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ABOUT THIS USER GUIDE
This publication covers installation and use of CDI Marker Data
Download and Analysis application software which is used to interpret
benchmarking data collected by and downloaded from the CD47-C
benchmarker. Use of the CD47-C unit–as well as a detailed explanation
of benchmarking–is covered in CDI Publication 89-09-0023-00,
CD47-C Time-based Benchmarker User Guide.
Menu commands may be selected via mouse or key combinations.
(Some instructions may refer to using a specific menu selection, but
the proper key combinations for the same menu items are also valid.)
All key names are represented in capital letters. For example, the
Control key is shown as CTRL; the Escape key is shown as ESC. Keys are
frequently used in combinations or sequences. For example, SHIFT-F1
means hold down the SHIFT key while pressing F1. CTRL-K means hold
down the CTRL key while pressing the letter K.
   and 8 indicate you are to press Up, Down, Right, or Left
arrow, or ENTER keys.


NOTE: This user guide is based on a U.S. English keyboard.
Your keyboard may differ slightly. And, as MS Windows is a constantlyevolving product, your Marker screen menus may or may not appear
exactly as shown in this user guide. Neither situation will affect the
functionality of Marker.
This symbol indicates a warning or note included to help you
make the best use of your CD47 or to prevent personnel or equipment
damage.
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OVERVIEW

MARKER OVERVIEW
Marker is a Windows application for downloading and reviewing
recorded data from the CD47-C non-volatile memory to your pc or
laptop.
Marker will also generate reports in ASCII or Microsoft Excel format
(CSV). You can customize these reports with a built-in report
configurator allowing automatic import of benchmarking data to a
proprietary inspection tool software.

GETTING STARTED
Installing Marker
The CD47-C Utility Flash Drive
(CDI Part 89-72-0001-00,
included with CD47-C kit)
contains this executable file:
			

MarkerSetup3186.exe

You may either copy it to your computer or run it directly from the flash
drive.
When launched, MarkerSetup3186.exe will initiate the setup sequence.
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INSTALLING MARKER

Installing Marker (cont.)
Take the default settings unless you wish to customize the installation.
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STARTUP
Launch
Launch Marker the same way you would any Windows application, i.e.,
click the Marker icon on your desktop (shown here)

or run via Windows Start menu.
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STARTUP

Marker Windows Interface
Marker uses the Windows Multiple Document Interface (MDI). Here are
the main elements of Marker’s data interpretation environment:

MAIN
MENU
TOOLBAR
RECORD
JOB NAME

RECORD FILE NAME

RECORDING
VIEWS
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Main Program Window
This is the first window you will see when Marker is launched.

TITLE BAR
MAIN MENU
TOOLBAR

Title Bar
Indicates current open job(s)
Main Menu
This is a standard Windows pull-down menu system. All available
Marker options are accessible here.
Toolbar Buttons
All available Marker options are also accessible here.
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The Popup Menu
The Popup menu is a handy menu that allows quick access to some of
Marker’s more often-used functions. When the mouse pointer is located
anywhere within the Waveform Display area, clicking the right-hand
mouse button will cause a small menu to appear floating above the
Waveform Display. From this menu you can make selections,
and when you do, the menu will disappear and return you to normal
working mode.

The Popup Menu contains most menu and menu items on main menu.
(They are described in their own sections.)
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Additional Display Options
Color Setup
The colors of the waveforms, and the background color can all be
modified by selecting the “Waveform Display Colors” option from
the “Setup” menu.
A typical dialog for
waveform display color
setup is shown here:

You may change the
waveform display and
background colors
individually by clicking
the triangle located at right to the color boxes.
Or you may set them to default colors (Noise=red, signal-blue,
magnetic=green, background=black).
Clicking on button Save the changes will make the new colors taking
effect, while clicking on button Discard the changes ignores the new
colors. A sample of new color scenario is shown at right-bottom of the
dialog. These settings, when changed, will be remembered each time
you load Marker.
Yin/Yang Button - Inverting Colors Quickly
This handy button, found on the toolbar and in the lower
rightmost corner of the display window when zoomed in,
inverts background color in the waveform display window.
This allows for easier viewing on some monitors, and may help resolve
printing issues.
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Yin/Yang Button (cont.)

Tooltip
Many of the fields in Marker have Windows tooltips. Tooltips pop up a
description of the item that the cursor is floating over. While this feature
may be useful for a while as you learn to use the system, you may wish
to remove them once you are an experienced Marker user.

The tooltips can be turned on and off
by Selecting the View menu, and then
selecting Tooltips. A check mark will
indicate whether Tooltips are currently
enabled or not.
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Recording Views
Recording Views window is the most important part of the Marker
interface. This is where you interpret CD47-C data to determine exact
pig passage time. (See pg. 34, Viewing and Interpreting Data)
TIME CURSOR

RECORD
NUMBER

WAVEFORM
DISPLAY

TABBED DIALOGS

Note that you can have more than one record file window open at the
same time. You can even have multiple windows of the same record file,
if desired.
Waveform Display
Recorded data transferred from the CD47-C unit is displayed as
waveforms.
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Recording Views (cont.)
Time Cursor
The Time Cursor is a thin vertical line that runs from the top to bottom
of the Waveform Display. You can drag the time cursor left or right
within the Waveform Display with your mouse.
As you drag the time cursor, the Cursor Offset and Time at Cursor values
will increase or decrease depending upon which direction it is moved.

Tabbed Dialogs
Tabbed dialogs contain information unique to each record file.
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DOWNLOADING DATA

Organizing Data
“Jobs”
Downloaded data from multiple pig runs means you will soon have
many data records (*.pig files) on your hands.
Here you see a number of data files
representing pig runs. Unless you
are the person who has created and
transferred these files, you might not
know which data record goes with
which pig run.
Jobs is Marker’s file organizing
scheme that enables you quickly and
easily organize these data records into
appropriate folders.
This also creates a new directory on your system hard drive for the Job
and all associated files. In the example below, a Job entitled brooklyn
has been created. Data records transferred from your CD47 are
automatically assigned sequential filenames and are stored in the new
folder.

You create a Job either by downloading data (pgs. 14–23), or by the
Create New Job menu command (pgs 24–27).
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OPERATION

DOWNLOADING DATA
Before you process jobs within Marker, you must download CD47-C
data. The CD47-C will retain benchmarking data even if powered
down (or if batteries have been removed) but it must be powered and
connected via RS-232 serial cable connection or internal Bluetooth
transmitter. (See pg. 24, CD47-C Time-based Benchmarker User Guide)
You can download data in either the unit’s STARTUP or SUSPEND
modes.
CD47-C Serial Output Menu
If you have not already done so, make sure the CD47-C Serial Output is
configured for either RS-232 or Bluetooth communication.

l

SAVE
SETTING

l Ç È TOGGLEl

l

DISCARD
SETTING

MENU OPTIONS

OR
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DOWNLOADING DATA

RS232 Serial Cable Downloading
The serial download cable (included with unit) has a four-pin circular
connector on one end and a standard DB9 male serial connector on the
other. The circular connector mates to a bulkhead connector on the
side of the CD47C and the DB9 to a computer or laptop.
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From the Marker window, select the cable icon or menu command
as shown.
SELECT ICON OR MENU COMMAND

Marker automatically handles all serial port settings and the download
communications protocol with the CD47-C. You need only select which
serial port to use.

SELECT SERIAL PORT
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DOWNLOADING DATA

If you are uncertain which port to select, start with COM 1 . If COM 1 is
currently in use by another device or is otherwise unavailable, you will
see this error message. (If so, select another port.)

A Timeout warning indicates that communication has not been
established or has been interrupted. Make sure unit is in STARTUP
or SUSPEND modes, the cable is properly connected, and/or battery
strength is sufficient.
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Data Transfer, Serial
Once you have established RS-232 connection, click the Start Transfer
button to begin data transfer. The Communication window will keep you
informed of
progress.

The CD47 Information
section of this
window will be
automatically filled
in as information
is extracted during
transfer process.

An alphabetic
character is assigned
to the end of
a filename each and
every time
a download
is performed.
(In this case, “A”;
the next transfer will
be assigned “B”
and so on.)
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DOWNLOADING DATA

Bluetooth Wireless Downloading
The CD47-C Bluetooth Version 2.0 serial module is a Class 1 device
with a possible range of 300 meters. The actual download range may
be reduced by the limitations of your pc/laptop computer’s Bluetooth
device and/or environmental conditions.* The pc/laptop computer
running Marker software must be equipped with a properly installed
and functioning internal or external Bluetooth device (included with
unit).
From the Marker window, select the cable icon or menu command
as shown.
SELECT ICON OR MENU COMMAND

Upon selecting Bluetooth device the CD47-C will automatically
configure and control all wireless downloads.

*NOTE: Windows 7/8 Bluetooth communication requires installation of Toshiba
or Broadcomm Bluetooth stack (driver).
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OPERATION

Data Transfer, Bluetooth
Once you have established Bluetooth connection, click the Start Transfer
button to begin data transfer. The Communication window will keep you
informed of progress.
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DOWNLOADING DATA

The second from top right LED will flash
every five seconds when the CD47-C is
configured for Bluetooth
communication.

These warnings indicate that communication has not been established
or has been interrupted. Make sure unit is in STARTUP or SUSPEND
modes, a Bluetooth device is properly connected and functioning, and/
or battery strength is sufficient.

Bluetooth Data Security
• Marker only recognizes CD47-C Bluetooth devices and ignores all
others
• Pairing of devices requires a specific and proprietary passkey
• Transmitted data is encrypted
• The data format and communication protocol is unique and 		
application specific.
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Visual Data Download Confirmation
The third from top right side LED will flash ON/
OFF for each data block transferred to Marker
during RS-232 or Bluetooth
download.

Storing Transferred Data
When download is completed you will be asked if you want the data
added to an existing job (default), to a new job, or discarded.
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DOWNLOADING DATA

Select from Existing Jobs
If you choose to add
downloaded data to an
existing job, the Open
Job window will provide
a list of jobs.

Create a New Job
If you choose to
create a new job for
downloaded data, the
Create New Job window
will appear. (See
following page.)

Discard Data
If you choose to discard downloaded
data, you will be asked to confirm this
action.

NOTE: it is good practice to always create a new Job before
transferring files to your pc that do not relate to any previous jobs.
NOTE: you must create a new Job if you intend to use Marker’s
database to generate a report. The database will not recognize a
passage or benchmark box that is not in a Job folder.

New and Existing Job details are provided on pgs 24–32.
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JOBS
Creating a New Job
Create a new Job via menu
command or toolbar icon.

A Create New Job
dialog box will
appear. Fill out each
field.
Job Name and Root
for Image Filename
fields will be fixed
upon saving, all
other fields may be
edited at any
future time.

Job Name is a 30-character field that will identify the Job. Regardless
of characters entered, only alphabetic characters, numbers, and
underscores will be used as a job folder name and .job filename in that
folder. (For example, if you enter My %_Job#$1 the folder name will
be truncated to My_Job1)
By default, the Job Name you enter becomes the root name for pig
passage record filenames.
Operator’s Name is an optional field. You can enter the name of an
individual primarily responsible for placing CD47 units in the field,
retrieving/interpreting data, etc. (If multiple names are to be entered, it
may be more convenient to use the Complete Job Description field.)
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JOBS

Root for Image Filenames is created automatically when you finish
editing Job Name. The character string will be used for the root of .pig
filenames. As with Job name, only alphabetic characters, numbers, and
underscores are accepted. The filenames will be created upon data
transfer from a CD47 unit to a hard drive.
For example: When you enter CD47 Testing for a Job Name of, a
root file name of CD47TEST is automatically created. As you transfer files
from a CD47 units, this name will automatically increment to reflect the
number of transfers that have taken place, and to keep the file name
unique (as it is not possible for two or more identical filenames to reside
in the same Windows folder.
If the user’s serial number of the CD47 box is 432, the first file that you
transfer from the CD47 would be called CD47TEST432A.PIG, the second
file would be called CD47TEST432B.PIG, and so on.
You may change the root filename that Marker creates for you by
clicking your mouse into the “Root for Image Filenames” field and
editing it. You are, of course, limited to 30 characters, and standard
Windows filenaming conventions apply (i.e. no punctuation, spaces,
slashes, etc.)
Complete Job Description is a 500-character field where you can enter
any information desired. Normally this field is used to completely
describe the job, specify placement of the units in the field, or any other
benchmarking-related information about the pig run.
Job Run Start Date/End Date is where you enter the starting and
ending dates of a pigging job. You may adjust these dates by using your
keyboard up/down arrows or the “spinner” to advance or set back
values by one day at a time.
NOTE: You cannot specify a Job Run Start Date that is later than the Job
Run End Date, nor can you specify a Job Run End Date that is before the
Job Run Start Date, although the two dates may be the same.
If the there is no response when you click on the spinner, make sure that
the dates are in proper sequence (i.e., start date earlier or equal to end
date).
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Time Zone field represents the number of hours that the pig job is offset
from Greenwich Mean Time (GMT). A list of time zone areas will be
displayed in a popup dialog by clicking
button “Time Zone
Area List” near the
time zone box.

Time Zone is one of
the most important
fields in the Jobs process. Although you can change this value at any
time by selecting Jobs|Display/Edit Current Job from the Main Menu,
you need to recalculate the passage times stored in database with the
new time zone.
The Time Zone value should be set to the time zone where the pig job
takes place. For example, if the pig run is being performed near New
Orleans, Louisiana, USA, set the Time Zone value to -6. If your pig run
takes place near Moscow, Russia, set the value to +3 hours.
See pg. ___ for a complete listing of worldwide time zones.
This Time Zone field is used when calculating the time displayed in Time
Tabbed Dialog as the precise time of the pig’s passage. If a pig passage
the time appears incorrect by some number of whole or half hours,
it is likely that the Time Zone number is set incorrectly. To correct the
problem, simply open the job using the menu selection Jobs|Display/
Edit Current Job and adjust this number to the true time zone offset
of the pig run location. When you are finished click on the Save Edits
button.
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JOBS

Job Creation Date is the only field that cannot be changed either before
or after a job is created. This field represents the date the Job was
physically created on the hard disk according to your computer’s clock.
It should always be the exact date you have created the Job. If not, it is
likely that your computer system clock is not set correctly.
Client Company is a 50-character optional alphanumeric field that can
be used to hold the name of a company that the pig run is for.
Client Contact is a 50-character optional alphanumeric field that can be
used to hold the name of a contact person from the above-mentioned
company.
Creating New Job (Example)
A completed Create
New Job dialog box
might look like this:

NOTE: it is good practice to always create a new Job before
transferring files to your pc that do not relate to any previous jobs.
NOTE: you must create a new Job if you intend to use Marker’s
database to generate a report. The database will not recognize a
passage or benchmark box that is not in a Job folder.
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Opening an Existing Job
Open an existing Job via Open Job menu command, toolbar icon, or
CTRL + J. Opening a previously-created Job loads all records associated
with that job from the
database.

You can also open an individual record (.pig file) via Open File
menu command, toolbar icon, or CTRL + O (see pg. 34, Viewing and
Interpreting Data).
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JOBS

When Marker is first installed there are of course no previous usercreated Job files. However, a folder named default.job is created during
Marker installation. If no job is opened when Marker is launched.
Marker defaults (hence the name) to default.job.
Default.job is useful as a “scratchpad” to store test data files, etc.

Open Job Dialog Box
The Selected Job field displays the Job that you have selected from the
list in the Select A Job field. If this field contains that name of the Job
that you wish to open, simply click on the Open Job button located on
the right side of the dialog box to open the Job and make it the “active
Job”.
When you select a Job for opening, the name of your opened Job
appears in brackets in the Title Bar at the top of the Marker main
window.
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Select A Job lists all of the Jobs created on your computer by
20-character filename. (When the listing of stored jobs increase beyond
the size of the box, a vertical
scroll bar will appear.)

Checking the View Job Details
box expands the Open Job
dialog box to reveal more
information about a job:
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JOBS

Display/Edit Current Job is accessed via menu bar. You can modify
job information–with the exception of job name and root for image
filename–here.

Job information existing in the database will also be changed
accordingly.
Opening Multiple Recording Documents
You can easily open more than one recording from pig or super files as
for comparison purposes.
For example: you may have performed a pig run twice, and each time
used a different Job directory to place the transferred files (which is a
good idea). To compare the same passage location in two different Jobs
you will have to open two different recordings from two different Jobs.
Do this just as you open an existing job (pg. 22).
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Copying [and Moving? does Marker “move” jobs?] Jobs
As Jobs accumulate on your pc hard drive, you may wish to copy some
of them to a CD or DVD for long-term storage. The Job Copy command
allows you to move one or more Jobs that you select from a list to
another drive.

Job Copy is primarily designed to be used to transfer Jobs quickly and
easily to one storage source to another for backup purposes, or to an
office hard drive a laptop computer used in the field.
Performing this action manually via Windows Explorer can be timeconsuming and error-prone. But by using Job Copy, you need only
concern yourself with Job Names; Marker will manage the transfer of
potentially hundreds of individual job and waveform files associated
with a Job.
Job Copy may also be used to copy Jobs from one PC to another across a
computer network.
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JOBS

If a Job by the same name already exists in a destination location, an
alert message will appear. Clicking Yes will overwrite the existing file, No
will cancel the operation.

Filenaming Conventions
To allow the same unit to be downloaded multiple times, An alphabetic
character is assigned to the end of a filename each and every time
a download is performed. As this was the first download of that
particular number under that particular job name, the letter “A” was
used. Should the operator choose to download the same unit box again,
the letter “B” would be added, etc., continuing all the way through the
letter “Z”. This naming convention allows a single CD47 unit, under a
single Job name, to be downloaded a total of 26 times before returning
to the letter “A”. (The 27th and after file transfer would use the letters
“_1”, “_2”, and so on.)
For example, file BK02251525 was downloaded from CD47-C unit
number 2525.
BK022515

2525		

A		

.PIG

root of image
filename		

CD47-C
Serial #		

first		
download		

extension
assigned by Marker

By being familiar with this convention,
you will always know which unit files
came from when looking at a Job
directory.
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VIEWING AND INTERPRETING DATA
Opening a Recording
From the Marker window, select the folder icon or Open File menu
command (or CTRL + O) to open a benchmarking data file.
SELECT ICON OR MENU COMMAND

Page 37 of 92

OPERATION

CD47-C MARKER USER GUIDE

Viewing a Recording
The Recording Views window is where you interpret CD47-C data to
determine exact pig passage time. You can toggle between various wave
form displays: Noise and Signal, Magnetic, or all three.
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Waveforms
The CD47-C records two simultaneous channels of magnetic
information. This is accomplished via a unique two-antenna design.
The Signal antenna is placed parallel to the pipeline, which
automatically places the Noise antenna perpendicular to the pipeline.
These two antennas together enable capture and reproduction of very
distinctive patterns of data when
viewed in Marker.
NOISE ANTENNA

SIGNAL ANTENNA

PIPELINE

As the CD47 detects
a magnetic event, it
analyzes it using these
two antennas to determine if it is a true pig passage.
For example, if a running automobile were parked to one side of the
CD47-C unit, various parts of the automobile could be casting off a
22-Hz magnetic field–precisely the signal that the CD47 unit is
looking for. However, the magnetic field detected by the Noise
antenna indicates that the source is in fact offset from the pipeline
and therefore not a valid pig passage signal. This signal is therefore
discarded.
Although CD47 firmware is written to discard such false triggers, it has
also been written to commit errors on the conservative side. This
means that if a magnetic event occurs, and the CD47 is not able to
precisely decide whether it is a pig or not, the unit will record it as if it
was a pig passage and let the you make the final decision about
the passage’s validity.
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Magnetic fields are threedimensional. A 3-dimensional
rendering of a typical Signal
field might resemble
this. (Note antenna
orientation.)

Concurrently, a Noise field
might resemble something like
this. (Note “null” point directly
over source.)
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As the pig passes beneath the CD47-C, it records the magnetic fields
detected by the Noise and Signal antennas.

NOISE CHANNEL

SIGNAL CHANNEL

The peak (highest point) of the Signal channel indicates closest passage
to CD47 unit.

PEAK
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Waveforms (cont.)
Marker processes the recordings and generates a two-dimensional
graphical waveform of each channel.

Marker enhances displayed waveforms by “mirroring” them.

The result is a visually distinct waveform that is easy to interpret.
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Basic Interpretation Skills
You will need to be familiar with a few basic skills to successfully
interpret recoded benchmark data.
Time Cursor
The Time Cursor is one Marker’s most important functions. It is a thin
vertical line that runs from the top to bottom of the Waveform Display.
You can drag the time cursor left or right within the Waveform Display
with your mouse, or click (once) with mouse cursor at any desired point
along the waveform.
As you drag the time cursor, the Cursor Offset and Time at Cursor values
will increase or decrease depending upon which direction it is moved.
TIME CURSOR

TIME CURSOR

CURSOR OFFSET: 0.047
TIME AT CURSOR: 06:16:09.951
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Recording Selection Buttons
If the CD47 unit has recorded more
than one passage, you can jump from
one recording to the next with the four
“Recording Selection” buttons shown here.
These buttons are similar to those on a CD
player or media player (which allow you
to move from one musical selection to
the next). The upper two buttons advance
forward or backward one recording at a
time. The lower two jump directly to the
first or last recording.
The large yellow digits located just above the Recording Selection
buttons indicate which recording you are currently viewing, and indicate
the total number of recordings available for viewing.
If you wish to see only valid passages, check the
Valid Record box with mouse, menu command, or
down arrow key q
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Recording Start Time
The Recording Start Time window lists each passage along with the time
and date that the passage occurred.
Access this window via menu command (View - Recording Start Times),
right-clicking anywhere in the Recording Views window, or by simply
pressing CTRL + R keys.

Double clicking on any of these passages will take you directly to its
respective waveform. Use the Recording Selection Buttons (previous
page) or up/down arrow keys
pq to navigate between
recordings.
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Tabbed Dialogs
Tabbed Dialogs provide important information about the passage
displayed in the Recording View window. They are located across the
bottom of every Recording View window and accessed by mouse.
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Tabbed Dialogs (cont.)
The Time tab is the most important because it allows you to calculate
the precise time of the current pig passage. (Which of course, is what
benchmarking is all about!) The Time Tab is always displayed first when
a Recording View is opened.

Each field represents a portion of a mathematical formula. This formula
is used by Marker to calculate the time of the pig’s closest passage, or
any other point in time of the recording that the user may be interested
in.
Pre-Calculated Formula
The Pre-Calculated formula for finding the pig passage time is shown
here:
PREVIOUS
GPS
Time/Date of
CD47 unit’s
most recent
GPS fix

TIME
ZONE

+

Pig Run’s
Time Zone
from GMT
(can be
negative #)

ELAPSED MS
BEFORE

+

Elapsed
milliseconds
since
most recent
GPS fix

CURSOR
OFFSET

+

Current
cursor offset
supplied
by Marker
operator

TIME AT
CURSOR

=

Precise
Pig Passage
Time

Post-Calculated Formula
A Post-Calculated formula option is also available that finds the Pig
Passage Time based upon the Global Positioning System (GPS) fix taken
immediately after the Pig Passage. When a job file is first opened, the
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default Time Cursor position in the Recording View window is at the
beginning of the waveform time line; i.e., 0.000 (zero seconds and zero
milliseconds).
TIME CURSOR

As mentioned earlier (pg. 40)
you may move the Time Cursor
anywhere along the time line via
mouse click or by dragging. As
the Time Cursor is moved, the
formula is recalculated.

To calculate the precise time of the pig’s
closest passage using the Transmitter
Channels, you must place the Time
Cursor at the point in the Signal
Waveform that represents the pig’s
closest passage point.

To calculate the precise time of the pig’s
closest passage using the Magnetic
Channel, you must place the Time
Cursor at the point where the positive
arc crosses the center threshold and
enters the negative arc.
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Once you have placed the Time Cursor at the point of the pig’s closest
passage, the time of the pig passage will be displayed in the Time
Tabbed Dialog field “Time at Cursor”.
Sometimes the passage times
of Pre-Calculated and PostCalculated are a different.
Marker always records
passage time calculated with
shorter “Elapsed time” in
database no matter what is
shown on screen.
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You have the ability to “collapse” the formula so that only the result
is displayed. This feature was added so that when more than one
recording file is open simultaneously, you are able to tile them and still
see the result as shown here:
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Millisecond Breakdown
Another useful feature included under the Time Tabbed Dialog is the
Millisecond Breakdown dialog box. As you have learned, the
(pre-calculated) formula for producing actual precise time of a pig
passage is displayed in milliseconds elapsed since the unit last acquired
a GPS time and position. This number of milliseconds can get very large.
For example, there are 86,400,000 milliseconds in a single day, and
604,800,000 milliseconds in a 7-day week. As the CD47-C has a
minumum battery life of 30 days, this number could reach as high as
2,592,000,000 in field use. Internally, the CD47-C benchmarker could
conceivably record raw milliseconds for nearly 35 years!
Occasionally it is useful to know the period of elapsed milliseconds
(before passage) in minutes, hours or days. So that you are not
constantly reaching for your calculator, Marker includes the Millisecond
Breakdown dialog box. When the “Time” Tabbed Dialog is visible, you
will notice that when the mouse cursor is positioned over the “Elapsed
ms before passage” text field that the cursor will change into a small
square clock as shown here:
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Click on this field while the mouse cursor is a clock pointer to bring up
the Millisecond Breakdown dialog box. This dialog box will show the
number of milliseconds (as in the
field when you clicked on it) broken
down into seconds, minutes, hours,
and days.

Click “Done” to return to normal
operation of Marker.

Position tab shows unit location as obtained from GPS satellites. This
position information, while not precise enough for benchmarking,* is
useful as a reference while viewing data.
This information allows you look up a benchmarking unit’s recording
position using standard maps and globes. It will be accurate anywhere
the recordings took place in the world, 24 hours a day.
The GPS position data is in standard Longitude, Latitude and Altitude
formats. Here, a Longitude of 95° 48.43 West by Latitude 36° 4.24 North
and an altitude of 194.19 meters [637.1 ft] is shown.

* see following page
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Note Regarding GPS Accuracy
As mentioned, the accuracy of this position information is not good
enough to aid us in our benchmarking efforts. How accurate is it?
The following is a quote from the Trimble SVeeSix - Marine and Bullet
Developer’s Guide.*
“GPS position accuracy is degraded by atmospheric distortion, satellite and
receiver clock errors, and Selective Availability (SA). Effective models for
atmospheric distortion of satellite signals have been developed to minimize
the impact of tropospheric and ionospheric effects. The impact of satellite
clock errors is minimized by incorporating the clock corrections transmitted
by each satellite used in the position solution. SA is the most significant
contributor to position error and cannot be effectively combated except with
differential GPS.
The U.S. Department of Defense, through a program called Selective
Availability, intentionally degrades GPS accuracy for civilian users. The SA
program creates position errors by modifying the apparent position of each
satellite and introducing random dither into each satellite’s clock. In extreme
cases all sources of error (natural, PDOP, and SA) can combine to produce
large position errors. The DOD’s definition of accuracy under SA is 100
meters 2 dRMS (horizontal 2 dimensional, 95% of the time).”

Obviously, a worst-case accuracy of “100 meters ... 95% of the time”
is not sufficient to locate a pipeline flaw. However, the United States
Department of Defense “Selective Availability” does not effect the
time information broadcast by the GPS satellites, only the positional
information.

* Trimble is the American supplier of the GPS equipment used in the CD47. The
quoted document is the SVeeSix - Marine and Bullet Developer’s Guide,
Trimble Part Number 23725-00 Rev. A.
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The Misc (Miscellaneous) tab displays a variety of information that was
collected from the CD47-C at the time of recording.
Battery Voltage: battery power available at the time of recording.
Temperature: the temperature inside the CD47-C at the moment
recording was taken.
Total Number Ignored: the total number of Ignored Events that have
occurred (events caused by ‘shock’, or a jarring of the box is a separate
value, recorded in the next field).
Ignored due to shock: passages discarded due to physical movement
detection.
Noise, Signal, and Magnetic Thresholds: each are “digital
potentiometers” set by the software to control sensitivity.
These values are determined by the as the appropriate the particular
location.
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About Unit displays more information about the CD47 unit itself.
Marker Version: the version of Marker that the recording data was
downloaded with (not the version of Marker that you are currently
using).
Firmware Version: displays the version number of the CD47 firmware
when the recording was made. This information can be important
when older recordings are being compared to newer recordings, as
the two firmware versions may have differences in the way that the
trigger or record data.
CD47 Serial #: the CDI serial number of the particular CD47 unit that
recorded this data. The CD47 Serial Number cannot be changed by an
owner or operator.
User Serial #: displays the serial number that has been entered into
the CD47 by a client. This number is used to identify the benchmarking
unit within the client’s pool of equipment.
Location Description: 500-character text field [reserved for a future
firmware release] that will display the location information entered
into the unit by the operator when the unit is placed in the field.

Raw Data contains miscellaneous information for advanced users and
debugging purposes.
Data Sample: total number of Analog to Digital (A/D) Conversion
samples that the CD47 benchmarking unit took during the current
recording.
GPS Week: the raw GPS week number as supplied by the GPS system.
This number indicates the number of weeks since January 6th, 1980
and is used to calculate Year, Month, Date information internally by
Marker.
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File Signature: used to determine if the PIG file is of the old or new
format. (This is not normally important to the end user.)
Sig/Noise Ratio: this is the value used to record the data file being
examined and the amount of “Noise” to “Signal” allowable for a
possible pig passage. If this number is 1:1, it is permissible for the
“Noise” channel to be reporting magnetic field strength that is just
as strong as the “Signal” channel. However, if the “Noise” channel
reports a magnetic field strength that is higher than the “Signal”
channel, the pig passage would be discarded as having “too much
noise.”
GPS Nav Ver and GPS DSP Ver: these fields represent the firmware
version of the software within the Trimble GPS cards. These numbers
are useful to determine if problems could be caused by these systems.
Noise, Signal and Magnetic A/D Value: represent the actual number
of bits that the computer in the CD47 read for the sample that the
Time Cursor is on. If you have the Raw Data tabbed dialog open and
move the Time Cursor within the Waveform Display area, you will see
these values change. As the Signal channel’s waveform rises, so will
the number of bits and the corresponding voltage reading. The same
is true for the Noise and Magnetic channel data. This function has
been included mostly for debugging purposes, however, it can provide
interesting data when waveforms are difficult to interpret.
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Advanced Skills for Viewing Recordings
Normally, the methods described above in the sections entitled
“Interpreting the Benchmarking Data” and “Basic Skills for Viewing
Recordings” are adequate to view and interpret that precise pig
passage times. On occasion, however, the signals recorded by the CD47
benchmarking units may be difficult to interpret. If the signal is very
weak because of pipeline depths, or the pig passage occurred in a very
short period of time, etc. the waveforms that you see may be distorted
or almost nonexistent. One of the most important things to remember
while interpreting waveforms is that you must interpret what the CD47
has recorded. If the CD47 recorded only pig passages and no false
triggers, there would be very little need for a program like Marker. Also,
knowing as much as you can about the run that has taken place, the
placement of the transmitter on the tool, the type of tool, etc. will help
you be successful in interpreting pig passages.
Interpreting Imperfect Waveforms
Not every waveform that the CD47 records will be as perfectly shaped
as the waveforms that you have seen so far in this manual. There are
many sources of magnetic interference that can distort the shapes of the
waveforms that you see in Marker, therefore, there is a section of this
manual devoted to them. As you become increasingly familiar with the
waveshapes caused by transmitters, your confidence level will rise and
you will be able to easily recognize transmitters, even is large amounts of
noise happen to be present in the recordings.
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Interpreting Axial Divergence
One simple and easily recognizable source of waveform distortion is
axial divergence. Axial divergence simply means that the CD47 was
correctly placed parallel to the pipeline, but was not located directly
above the pipeline. This can easily happen if the pipeline is not located
well, or if the operator has to try and place the CD47 unit above the
pipeline by sight. Fortunately it is very easy to interpret waveforms with
large amounts of axial divergence.
Shown here is a small example of axial divergence.

Note that the leading “shoulders” of both the signal and the noise
waveform are slightly weaker than the trailing shoulders. This indicates
that the unit was placed slightly to one side of a pipeline.
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Distortion From MFL Permanent Magnets
This image represents a recording of an MFL tool
equipped with a CDI model CD49-LC transmitter
in a 12-in. [304 mm] pipeline.
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As the tool passed beneath the CD47 antennas, we see large jumps of
signal prior to the transmitter.

This is normal, as the permanent magnets of the tool are very powerful
and can easily create signals that are within the CD47’s detection range
and frequency. As the tool strikes welds or travels through bends, larger
peaks of interference will be observed.
On this particular pig, it is useful to know that the transmitter was
mounted at the rear of the tool, 8 ft. [2.5 m] behind the powerful
permanent magnets. Knowing this allows us to predict that the
permanent magnet interference that we experience will be ahead of the
transmitter signal as shown here. (If the transmitter had been mounted
at the front of the tool ahead of the permanent magnets, then the
waveform would show interference after the transmitter signals.)
Because of the smooth wave shape of the transmitter pattern, this
particular image is still easily determined to be a pig passage (even
though it does not exactly resemble the “textbook” pig passages shown
earlier in this user guide.
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Here is another passage from a similar run. This waveform is more
difficult to interpret than the one on the previous page. The general
pattern of the transmitter’s passage is still present, however,
represented by the smooth increasing and decreasing signals.
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Interpreting A Stopped Pig Waveform
As pipeline valves are themselves typically used as benchmarking points
by the pig, you will seldom if ever see a recording like this.

Here, the MFL tool has struck a block with an inside diameter (ID)
reduction. This constriction has momentarily stalled the tool until
the rear pressure increases enough to overcome the blockage. This
stoppage is normal behavior for a
tool, especially when working in a gas
medium, as the gas will compress behind
the pig considerably before the pressure
overcomes the ID reduction.
Note the transmitter signal begin to rise
at the very beginning of the waveform.
Suddenly there is a large spike of signal. This spike of signal strength is
the tool striking the block valve and stopping, causing a strong signal to
suddenly be emitted by the permanent magnets. After the pig stops, the
signal from the transmitter remains constant for the next 60 seconds
(the CD47’s recording time limit).
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Examples of Imperfect Passage Recordings
The following waveform images are all valid pig passage recordings.
Some of these recordings look very much like what you would expect
a “perfect” waveform to look like and some do not. Some of them may
even be difficult for you to recognize as valid pig passages at first, but
after experience with the CD47-C you will probably find that interpreting
these recordings is not as difficult as it might seem at first.

Page 63 of 92

OPERATION

CD47-C MARKER USER GUIDE

As you can see from these images, waveform recordings can have
many different kinds of shapes. However, it is fairly easy to interpret
a waveform once you have a general knowledge of how the CD47-C
works and a reasonably good understanding of the pig run that was
performed.
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Interpreting False Triggers
The CD47-C has been designed to minimize the recording of information
caused by false triggers. However, as there are many different sources of
magnetic signals, some false triggering of the equipment is inevitable.
Here are several examples of valid recordings as well as examples of
false triggers to help you discern the difference.
Long False Triggers
A common source of false triggers is when the CD47 units are being
used to leapfrog from one location to the next on the pipeline. When
leapfrogging, it is important for an operator to place the unit into
“Suspend Mode” after the pig passes but before moving to the next
location. (See SUSPEND MODE, pg. 34, CD47-C Time-based Benchmarker
User Guide.)
If the operator does not place the unit into Suspend Mode, then the unit
will false trigger when transported. Movement of the unit in the earth’s
magnetic field generally causes waveform recordings that look like this:
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Three indicators of a false trigger caused by failure to use Suspend
Mode:
1. There will
usually be a great
more magnetic
disturbance shown
on the Noise
channel (top), and
less on the Signal
channel (bottom).

2. A waveform of a true passage will have a smooth rise and fall of a
signal. Compare this passage with the false trigger shown above:

3. False triggers caused by transporting the units from one location to
another are generally very long. Placing the Time Cursor at the very
end of these recordings usually shows the recording time to be about
60 seconds (60 seconds is the maximum recording time for any one
recording in the CD47 because of these types of false triggers).
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Here are four more examples of false triggers caused when Suspend
Mode was not used. Notice that they all look remarkably similar to each
other and follow the three guidelines described on previous page.

“Unpredictable False” Triggers
Occasionally, false triggers will be cause by sources other than omission
of the Suspend Mode. These false triggers can come from a very wide
variety of sources and are very difficult to predict.
It is often impossible to determine what causes a false trigger, however,
many times you will be able to determine a cause by knowing as much
about the pig run as possible.
For example, if you knew, that a CD47 was placed near railroad tracks,
you could determine that unusual false were caused by passing trains.
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Here are some examples of false triggers from unknown sources. While
it may not be possible to determine precisely what caused these false
triggers in the equipment, it is readily apparent that they are not valid
pig passages.

SIGNAL AND NOISE
WAVEFORMS ARE
SMALL, RANDOM,
AND SIMILAR IN SHAPE

TIME CURSOR PLACED
NEAR END OF RECORDING

SIGNAL AND NOISE
WAVEFORMS DO NOT
HAVE SHAPE OF TYPICAL
PASSAGE RECORDING
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“Zoom” Feature
Zoom allows you to magnify any portion of either the Signal or Noise
waveform and get as “close” to it as you like. To zoom in on a portion of
a waveform, hold down the SHIFT key, click the mouse pointer within the
Waveform Display area and drag a rectangle with background-inverted
color around the region that you would like to have filled the viewing
area as shown here:
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When zoomed in (and the complete waveform no longer fills the
Waveform Display area), the horizontal and vertical scrollbars become
active. These scrollbars are located at the bottom and on the right hand
side of the Waveform Display area. These scroll bars allow you to
move the signal to the right, left, up and down. As with most Windows
applications, clicking upon the small arrowheads at either end of a
scrollbar will move the waveform small increments to the left and right
or up and down.

All Marker functions, commands, and options are operable when
zoomed in.
Change Zoom Level
To increase the zoom level, select menu item View|Zoom|In.
To decrease the zoom level, select menu item View|Zoom|Out.
Restore full screen view with no zoom
To return to full screen, double click the waveform area with mouse, or
select menu item View|Zoom|No zoom.
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Amplification
When an especially weak signal
is recorded, the zoom function
alone may not help you interpret
its data. The waveform may
need to be amplified.
It would be difficult–if not
impossible–to determine this
image to be a pig passage
without enhancement.
The Amplification command is accessed by right-clicking over the
waveform (as shown here) or via the View menu.
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For example, this wave form, when
amplified at a 15:1 ratio...

...when redisplayed will
resemble this:

As you can see, amplifying the
waveform reveals that it is
indeed a passage recording.
NOTE: it is possible to not only open more than one recording view, but
you may amplify each recording as desired; each at a different factor.
NOTE: amplifying does not permanently change the recorded data. You
are only modifying the way Marker displays the data. Amplifications are
not saved to your recorded data files.
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Ignored Events
The one-hundred most recent Ignored Events are stored along with
each .pig file. In some diagnostic situations, this data can be used to
‘fill in the blanks’ should any questions arise about data that may have
been ignored during the associated pigging run. The familiar Recording
Selection Buttons allow navigation between the 100 events.

Closing a Recording
Once you have opened and reviewed your data, you will eventually want
to close it. Any of the standard Windows methods of closing a window
will work, but the two simplest ways
are via menu

or toolbar

Either will close a currently active Recording View window, so if you have
several open recordings, make sure that the one you wish to close is the
active window. To make a window the active window, simply click on any
visible portion of the window.
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CREATING REPORTS (MARKER VERSION 3.1)
Marker utilizes a relational database system for manipulating
benchmark data. The report-generation dialog can be opened by
selecting the menu item of Report|Generate from database if a whole
job is opened instead of a file. Here is a typical report generation
dialog box:

The dialog integrates four parts. The first part is filtering criteria for
recordings on the report. You may select recordings from a job, a pig
file, or CD47 box serial number.
You may select recording’s validity and exclude those recordings outside
your time segment. The default selects all recordings from current
opened job. In some case more than one pig files are from one CD47
box with the same user serial number in a job. Default “Later Than”
time is the time of the earliest recording in the job and default “Earlier
Than” time specifies the time of the latest recording in this job.
The second part selects what fields to be on the report and their name
order. Arrow forward and backward buttons transfer those fields
between the two field lists. Up and Down buttons change the order of
the fields on report.
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The third part enable sorting of the recordings on the report, based on
their record time, pig file name, and/or user serial number.
The forth part contains big buttons for report generation trigger. You
may use Save Settings button to save the current filtering criteria, fields
on report, and sorting settings to a text file. Later you may load them
from a text file by clicking on Load Settings button.
Clicking on Generate Report will generate a report based on the report
settings. By default Marker will export the report to Microsoft Excel and
leave report formatting to MS Excel. The Excel requires a version of 97
or later. If Microsoft Excel fails to open, Marker will
show the report in a list dialog. You may force the
report to display in the list dialog by clicking the
triangle on Generate Report button and select “In
Marker List” (shown below).

From the list dialog, you can save the report into a text (.txt) or commaseparated (.csv) file by selecting dialog’s menu Report|Save Report. You
may include the query criteria in the report file by selecting the menu
item Report|Include Query Criteria if it is not checked. Marker put
filtering criteria, selected fields and sorting criteria in the first three lines
of the saved file.
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Marker also let you have a look at the query criteria by selecting menu
Report|View Query Criteria. A message box pops up for the query
criteria:

Battery Life and Temperature Graphs
To view the battery life or the internal temperature of the CD47B for
the days during and prior to your pig run, Select ‘Battery Voltage Graph’
or ‘Temperature Graph’ from the view menu. The rightmost edge of
the window contains the most recent readings, and readings from the
previous days run towards the left. You may zoom in and out using
menu Zoom|In or Zoom|Out.
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Note: Marker always stores and displays 1008 temperature and battery
readings. If you scroll to the far left side of the screen, you will see the
oldest data. Some of this data may be from a previous job, or the area
may contain no data at all.
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DATABASE SYSTEM
Marker uses a relational database management system to manipulate
the passage recordings. Basically, there are three connected tables in
the database system: Job, Box, and Record.
Job stores all data associated with a job such as Job Name, client
company, Job Start and End Run Time, Time Zone, etc.
Box contains information associated with a CD47 unit (box) such as:
Box Overhead, Serial Numbers, downloaded Pig File Name, and Battery
and Temperature Data.
Record stores Record Head, Record Data, Start and Peak Time, Validity,
etc.
A job can contain many boxes and many recordings. A box can contain
many records. With Marker, you can add jobs, pig files (as boxes),
recordings into the database and then modify or delete them. You
can retrieve, query the data in the database system. You can view
all recordings in a job chronologically in the database. In short, the
database system provides much more flexibilities and convenience than
super-files.*
*Super files were part of older Marker versions released prior to Marker 3.1
Although this version does not create super-files, you can still open an superfile, as opening a pig file, and view all recordings there.

Management of Jobs with the Database System
You can add, modify, update, and delete a job to/in/from the database.
Marker provides two options for triggering these actions:
Menu items under Database|Job

or toolbar
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Job Addition
If an opened job is not in the database, you can add the job into the
database. As mentioned earlier, job information is stored in a file named
jobName.job in the job folder.
The job addition will not only add
the job information into the Job
table, but also add all its pig files
into the Box table and add all its
records into the Record table. So
when you add a job into database,
the Add a Job dialog box will
appear.
The dialog displays job path, job
name, and a list of pig file names
in the job folder.
Check/Uncheck All button lets you
choose or unselect all pig files.
Status field shows current action.
A user may check or uncheck
individual pig file by clicking on the check box at front of the file name.
Add job and passages in checked pig files triggers the job addition into
database. Marker will add job information first and then pig files one by
one.
The “Stop” button halts addition process. When check boxes in front of
pig files turn gray, they are added into database, therefore will no longer
respond to check or uncheck attempts.
Done will close the dialog.
Once a job exists in the database, you may modify, update or remove it.
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Job Modification
If an opened job exists in the database, you can modify the job
information in the database. When you modify a job, a dialog for job
display/edition will pop up, as described in the section of job display/
edit. After you make some changes and click on Save button, Marker
will change the job information in the database, as well as in the file
jobName.job in the job folder. A message box will pop up after job
modification as follows:

Job Update
If an opened job exists in the database, you can update current job in
the database. The action compares pig files in the job folder and boxes
in the database, and matches them one-to-one. If a box in the database
has no corresponding pig file in the job folder, the box and its records
will be removed from the database. If a pig file in the job folder was
not added into the database, it will be added into the database.
Message boxes for box removal and addition will pop up for notification.
Job Removal
If an opened job exists in the database, you can remove it from the
database. The action will delete the job and all its boxes and records in
the database. So a message will pop up first to alert you of this.

Clicking No will cancel the action. Clicking Yes will remove the job from
the database.
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Upon deletion, all records on the screen will be gone, as shown here:
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Management of Boxes (pig files) with the Database System
You can add and delete a box (pig file) to/from the database individually
provided that the pig file is opened individually and its job was added
into the database. Marker provides two options for triggering these
actions:
menu items under Database|Box

or toolbar
Box Addition
When a job was added into the database, you may open one of its pig
individually (such as with menu File|Open File). If the pig file was not
added into the database, you may add the pig file into the database.
Adding a pig file into table Box will also add its records into table Record.
Marker will notify you the result of the action:
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Box Removal
When a job was added into the database, you may open one of its pig
individually (such as with menu File|Open File). If the pig file was added
into the database, you can remove it from the database. Removing a box
will delete the box and all its records in the database. Marker will alert
you of this first:

If you choose Yes, the box and its records will be deleted as notified by
following message:
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Management of Recordings with the Database System
You can update one recording or all recordings in an opened pig file
or job if they exist in the database. Updating a record modifies only its
validity, peak time, and display amplification level. Marker provides two
options for triggering these actions:
Menu items under Database|Record

or toolbar
Update Current Record
Update current record modifies only current recordings on the screen in
the database. A message will notify you the result of the action:

Update All Records
Update all records modifies all recordings in the opened document (a
pig file or a job) in the database. A message will notify you the result of
the action:

Marker will ask you to update all records automatically in two cases
when you tried to change record’s validity at interface but have not
updated those recordings.
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One case is when you close the document, Marker will ask you to
update those records in the database:

Clicking on button Yes will update all records in the job as described in
Section Update All Records.
The other case is when you generate a report from the database, Marker
will ask you to update those records in the database before generating
report:

Clicking Yes will update all records in the job as described in the Update
All Records section. Clicking Cancel will cancel the action of report
generation.
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Marker enables the printing of the opened recordings (passages). A nonzoomed recording will be printed even if it is zoomed on the screen.
Marker enables printing of current, valid or all passages. The menu
options are under File>Set Print Target. Marker can also print several
passages in one sheet of paper. The menu options are under File->Print
Passages Per Sheet. For each passage, the print consists of two parts:
one part for waveform picture and the other for the recording description, detailed as below.
Job Name: current job name
Data File Name: name of the file that contains the current recording
Recording Number: the position of current recording in all recordings
in the document (pig file, super file, or a whole job)
Validity: whether this is a valid recording
Peak Time: the time at the vertical cursor line if the recording is valid
Start Time: the time at the beginning of waveform if the recording is
not valid
The time format is Hour:Minute:Second.mili-seconds Month/Date/Year
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Here’s an example of a printout
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If you have a question about Marker, first look in this manual or consult
the on-line Help for the solution. To use Help, press F1 and select the
category you want, or press F1 again to find out how to use the Windows Help system.
If you can’t find the answer in your documentation, contact you local
representatives or CDI directly. The current Internet E-mail address to
CDI has been provided for you to get help with Marker.
If you call, you should be sitting in front of your computer with Marker
running and the waveform in question open on the screen. You should
also have this manual at hand. Whether you call or e-mail, please
provide the following information:
• The version number of Marker that you are using.
• The version of firmware loaded into the CD47 benchmarking
units.
• A complete description of what happened and what you were
doing when the problem occurred.
• The exact wording of any messages that appeared on the
screen.
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Warranty
All equipment sold by Control Devices, Incorporated (CDI) is warranted
for a period of one (1) year from the date of shipment to Purchaser,
providing the instrument or equipment has not been modified, abused,
or used for purposes which it was not designed for.
Batteries, probes, leads, magnets, and other consumables subject to
wear are not covered by this warranty. CDI will repair or replace faulty
equipment during the warranty period when the cause is a defect
arising from faulty design, materials or workmanship.

Making a Warranty Claim
Equipment being considered for warranty repair, or a representative
sample thereof, must be returned to CDI at the Purchaser’s expense.
The equipment must be accompanied by the Purchaser’s written order*
describing the defect(s) and authorizing CDI to invoice the Purchaser for
any charges not covered by the warranty.
Upon receipt of the equipment and Purchase Order, CDI will examine
the equipment and make a determination of the nature and cause of
the defect. If the defect is not covered by the warranty, CDI will quote
to Purchaser the cost for replacement or repair equipment, and will not
proceed until Purchaser delivers a written acceptance of the quotation.
During the one year warranty, CDI will bear the cost to return units
repaired under the warranty back to the Purchaser’s domestic premises.
CDI will return units to foreign countries at Purchaser’s expense.

* Contact CDI at 1-800-580-4234, ext 143 for CDI RMA Form FM-03-0089
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Care and Maintenance
Equipment designed by CDI is protected against the environment in
which it is intended to operate. Much of the equipment is designed
for prolonged use in the field without any special maintenance other
than routine battery replacements. It is the Purchaser’s responsibility
to insure that proper precautions are taken during installation and
operation so that weather seals are in place, routine maintenance
occurs, etc. Failure to perform these operations nullifies this warranty.
CDI equipment should only be operated by qualified personnel who are
familiar with any and all manuals and procedures for said equipment’s
operation.

Service and Repairs
Cost for repairs not covered by the warranty or carried out after the
warranty period has expired will be charged at the current hourly or set
service rate, plus the cost of materials, upon approval by Purchaser.
Equipment for repair must be sent at the Purchaser’s expense and be
accompanied by the Purchaser’s written order describing the defect and
authorizing CDI to invoice the Purchaser for labor, materials and return
delivery cost.
No service or repair will be undertaken until an approved written order
is received from the Purchaser.
Operating equipment while in a damaged condition nullifies this
warranty.
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ABOUT CDI
CDI is a family-owned and operated business located in Broken Arrow,
Oklahoma, just 12 miles from downtown Tulsa. Incorporated in 1982, CDI
has proudly been manufacturing products in the United States for more
than 32 years. CDI currently employs 48 people in the areas of electronics
and mechanical design, software and firmware programming, electronics
manufacture, machining, and more.
All CDI products are designed and built completely in-house utilizing an
on-premises machine shop boasting six fully-automated CNC machines
as well as full-time electronics
assembly personnel.

